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Vitejte ve tfinacté lekci Skoly pouzivani programu
Poser, ktera byla tentokrat vytvorena pomoci verze
Poser Pro 2012.

Timto dilem Skoly Poseru pokraCujeme v sérii lekci,
které jsou vénovany morphingu (deformaci) obJektu
scény Poseru. V predchozich lekcich jsme si vysvétlili
pouZiti magnetl a zabudovaného morphovaciho
nastroje Morphing Tool. V této lekci si vysvétlime, jak
uravit tvar objektu scény pomoci externi aplikace.

Predem upozornUJl ze nékteré principy | popsane v této
lekci plati pouze pro aktualni verze pouzitych aplikaci
(Poser 9 a Poser Pro 2012), ale pravdépodobné budou
platit i ve verzich nasleduijicich.

Zplsoby morphingu, které jsme si jiz popsali v
predchozich lekcich maji tu nevyhodu, Ze nejsou
dostateCné sofistikované pro tvorbu detailnich Uprav
tvar(l objektd. V takovém pfipadé musime vyuZit
moZnosti exportu objektd scény Poseru do externi
specializované modelovaci aplikace, kde vytvofime
pozadované Upravy mnohem snaze.

Program Poser umi exportovat do mnoha 3D aplikaci
pomoci nékolika exportnich formatd:

Import

Export Image...

Upload RIB...

BVH motion...
3D Studio

Run Python Script...

Convert Hier File...

DXF
Page Setup... LightWave...
Print... Wavefront OBJ...
Exit VRML

COLLADA|RWY
ZBrush...

Ja osobné preferuji aplikaci ZBrush od ﬁrmy Pixologic,
kterou najdete zde:

Stejné jako Poser, je i ZBrush aplikaci s osobitym
zpusobem ovladanl ktery si Ize pomérné rychle osvojit
bez predchozich zkugenosti s praci ve 3D prostredi. Pro
pouziti v kombinaci s Poserem bude postacujici, kdyZ si
vysvétlime jen nékolik zakladnich funkci této aplikace.

¥
Vytvoreno za pouZiti programu Poser Pro 1012 : E
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Velkou vyhodou aplikace ZBrush oproti jinym je to,

Ze dokaze snadno a pritom velmi cpreazne pracovat

s nepravidelnymi tvary 3D objektd. Tyto upravuje
pomoci specialnich Stétcli obdobnou technikou, kterou
pouzwa]l sochafi pfi modelovam sochy z hliny. Vzhled
vysledného dila zde nezalezi ani tak na znalostech
programovani, ale zejména na uméleckém nadani.

Kdyz jsem pred bezmala jeden a ptl rokem pfipravoval
predchozi lekci, netusil jsem, jak se za tuto dobu
nékteré véci zméni ve prospéchu uzivateld. Aktualni
verze obou aplikaci, tedy Poser Pro 2012 a ZBrush
4R4 umi nyni navzajem prlmo
komunikovat. To znamena, Ze
pi soucasném spusteni obou
aplikaci je mozné vybrany 3D
objekt stfidave presouvat z Poseru do ZBrushe a zde
upravovat a nasledné posilat zpét. Toto zcela méni
ptvodni zpdsob vzajemného vyuziti obou aplikaci.

Vzajemnou komunikaci zajiStuje GoZ plugin ZBrushe.
Pomoci tohoto pluginu ZBrush komunikuje i s jinymi
aplikacemi a podpora pro Poser byla pfidana pravé ve
verzi 4R4. Aby komunikace fungovala, musite mit u
Poseru nainstalovan alespon servisni balicek SR3, bez
néj to fungovat nebude!

Pfejdéme nyni k praxi. Export 3D objektl mezi
Poserem a ZBrushem je mozny pomoci nékolika
technik. Nejprve si vysvétlime ten nejjednodussi
zplisob, kterym je vySe avizované piimé propojeni
obou aplikaci.

Zacneme tim, Ze si :
do pracovnlho okna &
Poseru nacteme néjaky

3D objekt (napriklad Y1,
postavu), jehoz tvar 5 =
budeme upravovat. N

Muzete pouzit cokoliv,

ja jsem pouzil postavu

REALCandy z portalu Renderosity, ktera je na bazi
zakladni postavy Poseru Alyson 2 (jeji obrazek je
pouzit na pozadi této stranky vievo).

Odkaz je zde:

Postavu jsem doplnil o vlasy, obleCeni a pfidal pozadl
do scény. To neni pro dalSi postup v lekci nezbytne
nutné a ja tak ¢inim zejména z estetickych ddvoda.

ZBRUSH4 -4
s te only brush you need

Poser4Fan

WEBOVE STRANKY

Poser4Fan

DISKUZNI FORUM



http://poser.smithmicro.com/
http://poser.4fan.cz/forum/index.php
http://www.poser.4fan.cz/
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POZNAMKA:

Zkontrolujte si, zda mate instalovany
potiebné soubory Poseru v adresari
GoZ pluginu aplikace ZBrush!

U postavy jsem nastavil zakladni pézu pomoci prikazu
Window > Joint Editor > Zero Rotations.

Autofi programu ZBrush na svych webovych strankach
podporu pluginu GoZ pro Poser oficidlné neuvadeéji.
Iniciativita vzesla zfejmé jen ze strany autorl Poseru.
Pri instalaci servisniho balicku SR3 Poseru se soucasné
uloZi potfebné soubory do slozky GoZ pluginu aplikace
ZBrush. Proto predpokladam, ze pro spravnou
instalaci je nutné mit ZBrush nainstalovan jesté pred
aplikaci SR3 balicku Poseru. Kazdopadné doporuCuji
zkontrolovat, zda doslo k vytvoreni adresare ,Poser",
v némz se nachazi soubor ,,GoZBrushToPoser.bat™.
Umisténi je nasleduijici:

pfipadné

Nyni ponechame Poser otevreny a spustime aplikaci
ZBrush 4R4 (nebo jeho vyssi verzi). Uvodni obrazovka

vypada priblizné takto (mam tam néjaké ikony navic):

(A

° ® 65 .
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Prvni, co musime ve ZBrushi udélat, je definovani cesty
k aplikaci Poser, aby obé aplikace na sebe videly. To
udelame pomoci menu Preferences > GoZ > path to
Poser. ZBrush po spusténi tohoto prikazu sam vyhleda
instalacni slozku Poseru a zobrazi nasledujici dialogové
okno (adresa v prvnim fadku bude u vas odlisna):

A version of Poser was found.
If the following location is correct, please click to select it.
Click on 'Browse' to select a custom location, or on 'Not installed' if it is not installed.

D:/Program Files/Folder Lock/Locker/Poser Pro 2012/PoserPro.exe

Browse...

Not installed!

Pokud ZBrush spravné najde instalacni slozku

Poseru, zobrazi cestu k jeho spusténi v hornim fadku
dialogového okna. Pokud k tomu nedojde, pouzijte
polozku Browse... z druhého fadku pro rucni vyhledani
pozadovaného adresare. Pokud byste chtéli z néjakého
dlivodu propojeni ZBrush - Poser zrusit, pouZijte
posledni polozku s nazvem Not instaled!

Jakmile mame zadanu spravnou cestu k Poseru,
kliknutim na ni dojde k uloZeni a uzavfeni dialogového
okna. Tim mame obé aplikace pripraveny ke vzajemné
spolupraci.

Pomoci pluginu GoZ miiZeme z Poseru exportovat bud’
celou postavu, nebo pouze nékterou jeji Cast. Nejprve
si vysvétlime, jak vytvorime morph celé postavy, tzv.
»Full Body Morph".

V Poseru aktivujeme postavu, kterou budeme
upravovat (v mem pripade Candy) zvolime prvek Body
a pouzijeme prikaz menu Figure > Export Figure Mesh
to GoZ...
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V nasledujicim dialogovém okné mézeme dale upfesnit
zpdsob, jakym bude postava do ZBrushe exportovana:

Pokud oznacime policko
Export Posed, postava
bude exportovana vcetné
aktualné nastavené pozy.
V opacném pripadé bude
exportovana v zakladni
nulové poze.

Moznost exportu postavy
v libovolné poze je
doslova prevratem v dosavadnim zpisobu spole¢ného
uzivani obou aplikaci. Dfive nebylo mozné postavu

s nastavenou pdézou do ZBrushe vibec exportovat.

To znesnadnovalo praci v pfipadé, Ze zamérem bylo
vytvoreni deformace tvaru postavy zplsobené jejim
ohybem. Nyni miiZeme postavu exportovat véetné
ohybu koncetin a deformaci vytvaret pfimo na ohnuté
koncetiné.

Momentalné ponecham policko pro export postavy
vcetné pdzy neoznaceno.

Dalsi polozkou dialogového okna Polygon Grouping
zvolime, jakym zplsobem bude exportovana postava
rozdélena do jednotlivych skupin polygond. Tyto
skupiny mlizeme pozde€ji ve ZBrushi samostatné
vybirat nebo skryvat. Na tomto misté se musime
rozhodnout, co budeme s exportovanou postavou ve
ZBrushi délat. Kromé Upravy tvaru postavy miizeme
totiz pomoci nastrojd ZBrushe pfimo na povrch
postavy malovat texturu. Po takovy prfipad je vhodné
exportovat postavu se skupinami polygond rozdélenych
podle stavajiciho materialu, tedy pouzijeme volbu
Material. My ale budeme upravovat tvar postavy, takze
pouzijeme rozdéleni skupiny polygond podle Casti
postavy zvolenim polozky Body Part a volbu potvrdime.
Po potvrzeni volby dialogového okna pomoci tlacitka
Yes dojde k otevieni okna aplikace ZBrush v tuto chvili
prazdného. Nyni klikneme levym tlacitkem mysi do
stfedu pracovni plochy a pfi stale stiskutém tlacitku
mysi tahneme az ke spodnimu okraji plochy. Na
pracovni ploSe se zobrazi importovana postava.

A ted’ pozor! V tuto chvili nesmime délat zadné jiné
ukony, nez ze prepneme ZBrush do editacniho rezimu.
Klikneme tedy na tlacitko Edit v horni nastrojové

listé. Pokud to neudélame, postava se ulozi na pozadi
pracovni plochy jako tzv.
2,5D objekt a jiz nepdjde
zpét prevest do 3D.
Timto mame postavu
Poseru exportovanu a pripravenu pro Upravy tvaru.

K dalSimu postupu prace bude vhodné znat alespon
zakladni funkce aplikace ZBrush. V ramci této lekce si
vysvétlime jen ty funkce, které jsou nezbytné pro Ucel
naseho zaméru. ZBrush je pomeérné rozsahly nastroj a
mnohé ukony v né Ize provést vice zplisoby, napriklad
pomoci menu, ikony, klavesové zkratky nebo kombinaci
klaves a pohybu mysi. Pro vaZnou praci doporucuji
prostudovat informace na strankach vyrobce:

Export Candy to GoZ/ZBrush?

|l Export Posed
Polygon Grouping:

© Material
@ Body Part

(=]

Zvolim tedy jeden z moZnych zp@isob(i ovladani,
ktery povazuji za nejvhodnejsi k obCasnemu
pouzivani ZBrushe a dale jej popisi.

Objekt na pracovni plose mdizeme priblizovat, ~— *:
otacet a posouvat nejjednoduseji pomoci IS
tlacitek ve svislé nastrojové listé vpravo. e
Tlacitky XYZ, Y a Z volime osy, podél kterych je
mozné s objektem otacet. ‘
Tlacitkem Frame pfizp@isobime vybrany objekt 7
velikosti pracovni plochy.

Stiskem tlacitka Move a naslednym pohybem
mysi se stale stisknutym levym tlacitkem
pohybujeme objektem v pracovni plose.

Obdobné pouZzijeme tlacitko Scale pro zménu pfiblizeni
nebo oddaleni objektu a tlacitko Rotate pro otoceni.
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Otacet objektem v pracovnim okné ZBrushe Ize také
klinutim levym tlacitkem mysi do okna mimo objekt a
tazenim mysi. Pokud béhem taZeni stiskmeme klavesu
Shift, objekt se srovna podle nejblizsi osy.

Po importovani postavy a po upraveni pohledu vypada
okno ZBrushe v mém pripadé takto:

('

BB e "

[ EX XL

2 1€ 5.
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Vsimnéte si, ze do ZBrushe byla |mportovana pouze
postava bez pfipojenych objektd - viasti a obleceni.
Pokud by jsme chtéli importovat postavu s oblecenim,
musime pouZit jiny zpdsob, ktery si vysvétlime pozde]|
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Upravy objektu ve ZBrushi se provad&ji pomoci
Stétcli. Potfebny Stétec vybereme kliknutim na ikonu
aktudlniho Stétce v levém panelu nastrojd. Po kliknuti
se zobrazi okno knihovny Stétcil, ze kterého si miizeme
vybrat ten poZadovany Stétec (VIZ obrazek vyse). V.
teto knihovné jsou sice jen zakladni Stétce, které nam
vSak budou bohaté stacit. Dalsi Stétce se ukryvaJ| ve
specializovanych sloZkach v pohyblivém pasu v horni
Casti pracovniho okna s nazvem LightBox. Stejné
pojmenovanym tlacitkem Ize tento pas opakované
zobrazovat a skryvat.

Pro bézné Upravy tvaru postavy vyuzijeme tyto Stétce:

Osobné nejvice vyuzivam Stétec Move.
Pomoci néj Ize uchopit a tahnout povrch
objektu libovolnym smérem. Pomoci néj je
mozné provést vétSinu pozadovanych Uprav.

DalSim Casto pouzivanym
& Stétcem je Clay, kterym obrazné
N - pridavame, nebo za soucasného stisku
kldvesy Alt ubirame ,hlinu® na
povrchu 3D objektu. 0
Zakladnim Stétcem, ktery se mlize
prilezitostné hodit je Standard, ktery
funauie obdobné jako predch02| Stétec.
‘ DalSim zajimavym Stétcem je Flatten,
; kterym srovnavame povrch objektu do
roviny.
Poslednim, Casto pouzivanym Stétcem
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je Smooth, kterym miizeme Vvyhladit
povrch 3D objektu, Tento Stétec je
dostupny vyhradng stiskem klavesy Shift.
Doporucuji tento Stétec pouzit az na
zavéreCné vyhlazeni povrchu po dosazeni
poZadovaného tvaru a to jenyv nezbytné
nutné mire. Tento nastroj mize pfi intenzivnim pouZziti
zplsobit smrsténi velikosti polygon{ objektu a mohou
vzniknout trhliny v navaznosti mezi jednotlivymi
skupinami polygond.

U kazdého Stétce si dale mizeme vybrat, jakou stopou
bude na povrch objektu plsobit. Zakladni pfedvolby
stopy zobrazime po kliknuti na ikonu aktualni stopy
pod ikonou Stétce v levém panelu nastrojli. Nejcastéji
pouzivanymi stopami budou FreeHand a Spray.

Mouse Avg 4

Stopu Stétce mdzeme dale doplnit alfa kanalem, jehoz
polozka se nachazi pod ikonou stopy Stétce v levém
panelu nastrojd.

‘ Quick Pick
Apha oFf Apha 2 Apha 58

-

» (0] »

o & o %
P Alpha 25 Alpha 2¢€ Alpha 31
4+ * .
Apha 33 Alpha 34 Aipha 39

. -

L J .
— B ] i 11 ([T I—

Export Ep Make Tx  Make 3D (&3 CropAndFill | GrabDoc

K nastaveni velikosti stopy Stétce slouzi ovladace v
horni nastrojové listé ZBrushe. Pomoci téchto ovladacl
nastavime velikost stopy
Stétce, rozsah opadnuti
ucmku stopy, intenzitu a
smér plisobeni stétce vici povrchu objektu.

Vratme se nyni k postavé, kterou mame nactenu v
okné ZBrushe. Postava byla importovana bez textur
a je vybarvena standardni jednolitou barvou, ktera
je pro nasledné Upravy
tvaru vyhovujici. VSimnéte
si, Ze postavy Poseru

maji pomérné velké
polygony. V mém pripadé
ma pou2|ta postava
pouze néco malo pres

61 tisic bodd. Vyhodou
ZBrushe je to, Ze dokaZe
jednoduse polygonovou
sit’ rozdélit na drobne15|
prvky a pozdéji sit’ vratit
do puvodni velikosti bez

SR zsub Focal shift 0
z !ntenslt‘lﬁ

Geometry
Lower Res

SDiv 4
Del Lower

Freeze SubDivision Levels

Smt

Divide
jejiho porusem Zachovani Juv  ReUV
poctu polygond je
nezbytnym predpokladem ~ Edoctoop
pro navraceni upraveného crease
objektu zpét do Poseru. R
MoZznost doc¢asného -
rozdéleni polygonové LiavEolish
sité nyn| uzijeme pro DynaMesh
precizné&jsi Upravy tvaru. e ——

Geometrii postavy
rozdélime pomoci menu
Geometry na pravé
strané okna ZBrushe.

Modify Topology

MeshIntegrity
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POZNAMKA:

Pro urychleni préce pouzivejte funkci
symetrie - klavesa X.
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Po rozbaleni menu musime nejprve deaktivovat
standardné spusténou polozku Smt, ktera pri déleni
geometrie vyhlazuje povrch objektu. JelikoZ si v tomto
pripadé neprejeme, aby byla cela postava vyhlazovana,
musime tuto polozku vypnout jesté pred samotnym
délenim geometrie.

Geometrii rozdélime kliknutim na tlacitko Divide. Pro
optimalni praci se mé osvédcilo rozdéleni do ctvrté
drovng, CehoZ dosahneme opétovnym stiskem tlaCitka
Divide (celkem 3x). Po rozdéleni geometrie se aktivuje
v horni ¢asti menu posuvnik s nazvem SDiv, kterym
mdzeme prepinat mezi jednotlivymi hladinami deleni
geometrie (v tomto pripadé 1-4). V hladiné 1 je
originalni geometrie. O rozdéleni geometrie do Ctvrté
hladiny svedci celkovy ) ) i
poéf,at ,bOdfl,vkter)’/Ch macm ActivePoints: 3.705 Mil
nyniVicees 3,7 m|I|onlel. TotalPoints: 3.705 Mil
Nyni jsme pripraveni zacit

s tvarovanim objektu postavy. Model postavy, ktery
jsem poufZil je podél osy x symetricky. Proto si mohu
praci usnadnit spusténim funkce symetrie stiskem
klavesy X. Opakovanym stiskem teto klavesy je mozné
funkci symetrie zapinat nebo vypinat. Pokud funkci
zapneme, dojde ke zdvojeni kurzoru a cokoli udélame
na jedné strané postavy, automaticky se zkopiruje na
stranu opacnou.

Jakmile mame symetrii aktivovanu, pfiblizime si pohled
na upravovanou cast postavy, zvolime vhodny stétec,
silu jeho Ucinku a mlzeme ,malovat" tvarové zmény.
Majitelé tabletl mohou pro urceni sily Ucinku stétce s
vyhodou vyuzit pritlaku pera.

V pripadé neuspokojivého vyskedku prace mizeme
pouzit funkci z menu Edit - Undo. Mnohem pohodInéjsi
je vSak za stejnym UcCelem kliknout na odpovidajici
misto pasu historie, ktery se nachazi bezprostiedné
nad hornim okrajem pracovniho okna ZBrushe.

Projection  |iohtBox
Master

D

QuTek - M shP Mrgb  Rgb M
B m 8 4@

Undo History 9 out of 12

1:45:12 PM December 25, 2012

V ramci této lekce provedu Upravu hrudniku postavy,
spocivajici ve zvyraznéni zeber. Vychozi tvar hrudniku

je nasleduijici:
a4

Pfesto, Ze jsem dfive avizoval, Ze se Stétec Smooth ma
pouzivat jen v nezbytné nutne mife a nejlépe az na
zavérecne vyhlazeni hotového dila, pouZiji jej nyni na
pfedb&zné urovnani povrchu postavy, abych mohl Iépe
posoudit zmény tvaru provadené pozdéji.

I kdyZ je geometrie modelu postavy rozdélena o
dal3i tfi nasledujici hladiny, tvar povrchu postavy se
tim nezménil, protoze jsme béhem déleni geometrie
vypnuli automatické vyhlazovani. Stale jsou viditelné
ostré prechody mezi ptvodnimi polygony z prvni
hladiny. Vyhlazeni provedeme Stétcem Smooth s
nastavenou intenzitou Z Intensity maximalné na
hodnotu 5. U tohoto Stétce mizeme hodnotu ménit
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pouze pfi stisku klavesy Shift. Po vyhlazeni vypada
hrudnik postavy takto (nachazime se ve 4. hladineé

déleni geometrie):

Po vyhlazeni povrchu postavy v misté uprav mizeme
pouzit dalsi stetce k detailni uprave tvaru hrudniku.

Schvalné jsem to s tou Upravou tvaru trochu prehnal,
aby byla zmena na prvni pohled viditelna. Vysledek

vidite na obrazku nize:

Po dokonceni Uprav se musime pomoci posuvniku
SDiv vratit do prvni hladiny geometrie, ktera odpovida
plvodni Jpostavé z Poseru. Diky malému poctu
polygontll bude povrch postavy opét s viditelnymi
hranicemi polygon(, ale provedena Uprava tvaru bude
v maximalni mozné mife zachovana.

Pokud jsme s vysledkem
prace spokojeni, miizeme
upravenou postavu
odeslat zpét do Poseru.

K tomuto Ucelu slouzi
drobné tlacitko GoZ v
paleté Tool v pravém
hornim rohu obrazovky
ZBrushe.

Po kliknuti na tlacitko
GoZ se zobrazi informacni
okno, které potvrdime
tlacitkem Continue.

Timto dojde k aktivovani
okna Poseru, ve kterém
se zobrazi dialogové

okno informujici o
importu modifikovaného
geometrického modelu

Tool O
Load Tool Save As
Import Export

Clone Make PolyMesh3D
Clane All SubTools
GoZ all Visible R

Liab*oox) Tools

Body!10. 41 R
——a»

! Cylinder: Polyes

S

SimpleBr Body!l

postavy a s nabidkou nazvu budouciho morph targetu.

Import modified geometry as full body
morph for Candy?

|ZBrushFBMorph|

" Cancel | OK

Nazev mlizeme zménit,
ale ja ho v tomto
pripadé ponecham

a potvrdim nabidku
stiskem tlacitka OK.

Ovladac pravé
vytvoreneho morph
targetu celé postavy



najdeme v paleté
parametr{l prvku Body
postavy v kategorii Other.
Po vytvoreni je jeho
hodnota nulova. Aby

se Ucinek deformace
projevil, musime tuto
hodnotu zménit na 1,000.

Timto mame Upravu tvaru postavy Poseru dokoncenu.
Pokud jste s vysledkem spokojeni, miiZete ZBrush
uzavfit. V opacném pfipadé muzete pokracovat ve
ZBrushi v dalSich Upravach a opakované je tlacitkem
GoZ odesilat do Poseru. Zde je mizete ukladat pod
plivodnim nazvem, nebo vytvorit dalsi verze deformace
pod samostatnymi nazvy.

Na obrazku nize mlzete posoudit vysledek deformace

v mém vzorovém pfipade. Vlevo je postava pred
deformaci, vpravo je vCetneé deformace.

Other

* REAL_Candy
« [T » 4 gop ©° P

* ZBrushFBMorph
« [T > 4 ggp ©° P

Morph
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Nyni si vyzkousime, jak funguje prevod postavy vcetné
nastavené pdzy. Na postavu v Poseru tedy aplikujeme
libovolnou pozu.

U postavy opét zvolime prvek Body a pouZijeme prikaz
menu Figure > Export Figure Mesh to GoZ...

V nasledujicim dialogovém okné oznacime policko
Export Posed a volbu potvrdime. Postava bude tedy
exportovana vcetne aktualné nastavené pozy.

Po otevireni pracovniho okna ZBrushe klikneme levym
tlacitkem mysi do stfedu pracovni plochy a pfi stale
stiskutém tlacitku mysi tahneme az ke spodnimu okraji
plochy. Na pracovni ploSe se zobrazi importovana
postava vcetné pdzy, kterou jsme v Poseru nastavili.

Pro pfepnuti do editaCniho reZimu klikneme na tlacitko
Edit v horni nastrojové listé.

PoserClassroom
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Vsiméte si, Ze pokud nyni spustime rezim symetrie
stiskem klavesy X, tento jiz nebude fungovat korektné.
Postava v nastavené poze totiz neni v tuto chvili
symetricka podle osy x.

esseroe

A AO?&T

Pokud budete v budoucnu ZBrush pouzivat k prvotni
Upravé tvarli postavy, je vhodné&jsi postavu importovat
v zakladni nulové poze, kdy vyuzijete fukci symetrie

k urychleni prace. Importovani postavy s predem
nastavenou pdzou je uzitecné v pripadé, kdy naptiklad
potrebujeme upravit tvar ohnuté koncetiny.

Jesté nez okno ZBrushe uzavieme, vyzkousime si,

jak se v ném vybiraji jednotlivé skupiny polygond.

V nasem pripadé tyto skupiny koresponduiji s
odpovidajicimi ¢astmi postavy. Skupiny vybereme
kliknutim na kterykoliv polygon pozadované skupiny
pri soucasném stisku klaves Ctrl+Shift. V pracovnim
okné zlstane zobrazena pouze vybrana skupina,
ostatni budou skryty.

Takto napfiklad vyberu

levé stehno postavy.

Zpétného zobrazeni

celé postavy docilime
kliknutim do prostoru
pracovniho okna mimo
jakykoliv objekt, opét pri
soucasném stisku klaves
Ctrl+Shift.

Timto zplisobem mdZeme pracovat jen s urcitymi
Castmi postavy, pri¢emz provedené Upravy neovlivni
skryté casti. Na druhou stranu si musime uvédomit, ze
pokud vytvofime néjakou deformaci u okraje vybrané
Casti postavy, mdze vzniknout skokovy prechod mezi
sousedni casti, ktera nebyla deformaci ovlivnéna.

Pro Upravy dilcich Casti postavy je proto vhodné

ponechat zobrazené jeste jeji nejblizSi sousedni Casti a
timto se plynule dostavame k problematice maskovani.

Principem maskovani ve ZBrushi je to, Ze zamaskované
Casti objektu nejsou provadénymi Gkony ovlivnény.
Pokud potiebujeme upravit tvar néjakého Clenitého
objektu, kdy nemd&zeme pouzit dostatecné malou stopu
Stétce tak, aby nezasdhla na casti, které si neprejeme
ovlivnit, musime tyto casti skryt nebo zamaskovat.
Vyhodou maskovani je to, ze kdyz zamaskujeme jen
urcitou plochu Casti postavy, zbyla nezamaskovana
plocha mdZze byt dale Gpravovana.

ZBrush navic reaguje na intenzitu maskovani, takze
pokud okraj maskované plochy bude plynule mizejici,
stejny mizejici (cinek bude mit v této casti postavy
pouZity Stétec.

Maskovani aplikujeme

na povrch postavy

Stétcem, ktery aktivujeme

stiskem klavesy Ctrl.

Zamaskovana plocha je

zobrazena tmave hnédou

barvou. Opét mizeme

pro tento stétec nastavit

velikost stopy a droveri

odeznéni jejiho okraje.

Vyzkousejte si sami, ze
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zamaskovana plocha je viéi Gcinku deformace imunni.

Pokud to s maskovanim pfeZzeneme, mtizeme pouzit
Stetec na odmaskovani, ktery aktivujeme soucasnym
stiskem klaves Ctrl+Alt.

Pro dalsi praci s
vytvofenou maskou je
urCena paleta tlacitek pod

Masking

| Inverse

Clear Maskall
nazvem Masking v pravé
¢asti ObraZOka BlurMask SharpenMask
T|aCItkem ViewMask GrowMask ShrinkMask

mdzeme vytvorenou
masku stfidavé ’
zobrazovat, nebo skryvat.  Mask By Fibers

Tlacitkem Inverse Mask By AO
menime zamaskovanou a
nezamaskovanou plochu

Create Alpha

Mask By Cavity

naVZéjem_ Mask By Smoothness
Clear slouzi k vymazani Mask PeaksAndValleys
masky.

Mask By Color
Naopak tlaCitkem MaskAll
zamaskujeme vSe co je
aktudlné zobrazeno v Apply
pracovnim okné.

Nyni se ale vratme zpét k vybéru vice Casti postay

do pracovniho okna. Maskovani nam pfitom pomUize.
Cvicné si vyzkouZime vybér celé levé nohy postavy od
chodidla az po pas.

Pokud mate postavu v tuto chvili maskovanu, tuto
masku vymazte tlaCitkem Clear.

Nasledné vybereme pas postavy kliknutim na n&j
soucasné se stisknutymi klavesami Ctrl+Shift.

V okné zlistane pouze objekt pasu postavy. Ten
musime kompletné zamaskovat, pouzijeme tedy
tladitko MaskAll. Po zamaskovani (ztmavnuti) pasu
opét zobrazime celou postavu. Klikneme soucasné se
stisknutymi klavesami Ctrl+Shift do volného prostoru
pracovniho okna.

Obdobnym zplsobem postupné zamaskujeme dalsi
Casti levé nohy postavy,
tedy stehno, lytko

a chodidlo. Jakmile
mame vybér vSech
poZadovanych casti
dokoncen, zobrazime
celou postavu a vzajemné
zaménime zamaskovanou
a nezamaskovanou
plochu stiskem tlacitka
Inverse. Vysledek vidite
na obrazku vpravo:

Pokud nyni pouZijeme n&jaky Stétec na deformaci,
bude mit vliv pouze na levou nohu postavy a jeji pas.

Po dokonceni Upravy tvaru nemusime masku mazat, na
export upravené postavy do Poseru nema zadny viiv.

Castym pfipadem, kdy budeme vyuzivat ZBrush, je_
Uprava tvaru obleeni podle tvaru postavy. Presto ze
jsme exportovali postavu, ktera byla oblecena, prvky
obleceni nebyly do ZBrushe odeslany. Je to dano tim,
Ze v jednu chvili je moZné exportovat pouze jednu
postavu a objekt oblgceni je zde tvofen samostatnou
postavou (figurou). ReSeni tohoto pfipadu si tedy nyni
vysvétlime.

Pfipravime si v Poseru obleCenou postavu v zakladni
nulové péze a v dalsim okné si otevieme ZBrush s
novym prazdnym dokumentem.

Dle postupu popsanému na strané 2 nejdrive do
ZBrushe exportujeme samotnou postavu. V dialogovém
okné Polygon Grouping musime béhem exportu

vybrat rozdéleni skupiny polygond podle casti postavy
zvolenim polozky Body Part.

Po spusténi editaCniho reZzimu ve ZBrushi se pfepneme
do okna Poseru a zde aktlvu1eme objekt obleceni.
Jiz vime, Ze obleceni midZe byt tvoreno bud’ figurami

Mask By Alpha

PoserClassroom
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(Figures), nebo pouze rekvizitami (Props). V mém
pfipadé mam pouzity oba druhy obleceni, aby

bylo mozné demonstrovat jejich rozdilné pou2|t|
Podprsenka je na bazi figury, kalhotky jsou rekvizitou.

GoZ plugin zatim funguje korektné pouze pfi pouZiti
obleceni na bazi figury, s rekvizitami ma néjaké
problémy. Je mozné, ze s dalSim vyvojem budou
opraveny. Detaily si popiseme dale.

TakZe v Poseru si nejprve aktivujeme objekt obleceni
ngl bazi figury, ja tedy gktlvuy obJekt podprsenky Nyni
obleCeni exportujeme do

Zbrushe Upiné stejnym w
zplisobem, jako predchozi [k Gt
postavu, kterou tam jiz Lock Acter
mame Change Parent...

V praCOVn|m Okne Ad.d Constraint...
ZBrushe se zobrazi pravé Point AL..
importovany objekt
obleceni. Opét se vratime
do Poseru a exportujeme
objekt obleceni na bazi
rekvizity, tedy u mé to
budou kalhotky.

Rekvizity (Props) se
ImpOFtUJI QomOCI GOZ Create Magnet
pluginu z Casti odlisné od Create Wave
figur. V pracovnim okné Create Wind Force
Poseru si aktivujeme
poZadovanou rekvizitu a
pouzijeme pfikaz menu
Object > Export Object ~ Tool O
Mesh to GoZ... Dale jiz

pokracujeme stglne jako | Load Tool
v predchozich pfipadech.  1,,p0rt Enot

ZBrush oznaCuje
importované objekty
nazvem Tool. V paleté e Gl SNSICEE

se steJnym nazvem Goz  all visible R
vidime, jaké objekty jsou
aktualné k dispozici.
Plvodné importovana
postava je zde oznaCena
jako Body1! 4, pravé
importovana podprsenka Cylinder: Polyhles
jako Body1! 5 a 6
kalhotky dostaly nazev

CandyPanty!1. Nazvy
vychazeji z pojmenovani -~
importovaného objektu v
Poseru.

Aby jsme mohli ve

ZBrushi pracovat s SubTool
vice objekty najednou,
musime nejprve definovat
seskupeni objekt pomoci
palety SubTool. JeSté neZ
tak ucinime, vybereme

si jako zaklad seskupeni Body!l S

objekt postavy v paleté @ ()
Tool (Body1! 4) tim, ze
na nej klikneme. Postava
se zaroven zobrazi v
pracovnim okné ZBrushe.

Rozbalime si paletu

SubTool na pravé strané el v
pracovniho okna ZBrushe P
a v ni mame v tuto
chvili zobrazenu pouze
polozku s postavou. All Low All High

K ni pfifadime objekt

obleceni tak, ze klikneme

na tlacitko Append av . Append
nasledné zobrazeném Coulcais

okné klikneme na polozku

objektu obleceni, ktery si Del Other
prejeme seskupit. Timto elete pel All

Replace Body Part with Prop
Load Morph Target

Spawn Morph Target

Export Object Mesh To GoZ...

Create Grouping
Create Light

Create Camera

Delete Object

Save As

Clone Make PolyMesh3D

Lightbox) Tools
CandyPanty!l. 49 R
S -

Simplet'r Body!l 4

Body1 S

L J o

.. ®® o

CandyPanty!l

Rename AutoReorder

Inserc
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upravovat tvary oblecem podle tvaru tela postavy

zgusobem si vytvofime skupinu, ve které bude postava
vCetné obleceni. Cela skupina ted bude zobrazena
v pracovnim okné ZBrushe a mlZeme zde snadno

X X TX )
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Mezi jednotlivymi objekty v pracovnim okné ZBrushe
pFepiname pomoci palety SubTool. Pravé aktivni

objekt je vybarven svétlej$im odstinem Cervené

barvy, ostatni objekty maji odstin tmavsi a chovaji se
jako zamaskované, nereaguji tedy na Upravy. Objekt
ktery chceme upravovat

musime nejprve vybrat -

aktivovat. e m—

Abych mohl demonstrovat
zpetny pfesun upravenych
prvkid obleceni do Poseru,
cvicné jsem oba prvky
upravil.

Pravy kosicek podprsenky

jsem deformoval

posunem smérem dol(,

stejnym zplisobem jsem

deformoval pravou stranu §
kalhotek (viz obrazek i
vpravo).

Zpétny export obleCeni

na bazi figury do Poseru je snadny. V paleté SubTool
aktivujeme objekt podprsenky Body!1 5 a nasledné
klikneme na tlacitko GoZ v paleté Tool. Tim se
automaticky prepneme do pracovniho okna Poseru.

Ten nam nabidne dialogove okno, ve kterém mlizeme
vhodné pojmenovat vysledny morph target (deformaci)
a tento ulozit. Nové vytvoreny otocny ovlada¢ morph
targetu najdeme v knihovné ovladacu prvku Body
objektu podprsenky, v sekci Other. Pokud tento ovladac
nastavime na hodnotu 1,000, muzeme posoudit
vysledny efekt. Predpokladam Ze bude presné
odpovidat tvaru vytvorenému ve ZBrushi.

Zpétny export obleCeni na bazi rekvizity je v dobé
psani této lekce problematicky. Pokud pouzijeme stejny
postup, ktery jsme si pravé vysvétlili, vysledny morp
target se sice vytvor| na spravnem misté v Poseru, ale
jeho Ucinek zpdsobi efektni destrukci objektu oblegen.

Je mozne, Ze s dalSimi

verzemi Poseru nebo "
ZBrushe se tento problém

podafi odstranit a export ‘
bude stejné jednoduchy

jako u obleceni na bazi

figury. .
Presto si nynl’ ukazeme 1
alternativni zplsob, jak #

dostat provedenou upravu

tvaru obleceni do Poseru.
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Pouzijeme zplisob, ktery se pouzival pfed vznikem
pluginu GoZ ZBrushe.

V mém vzorovém pripade je objekt kalhotek tvoren
pouze jednou Casti - rekvizitou (Props).

V paleté SubTool aktivujeme nejprve objekt kalhotek
CandyPanty!1 a nasledné klikneme na tlacitko Export
v paleté Tool. Zobrazi se standardni dialogové okno

s nabidkou na uloZeni souboru upravené geometrie
objektu obleceni ve formatu obj. Pouzijeme nabidnuté
pojmenovani souboru nebo si zvolime vlastni a soubor
uloZime na disk nékam, kde jej pozdé&ji lehce najdeme.

/% Export Mesh... XD

9 ErrarT s T
B= Zobrazeni v B Nova slozka -'®'

Datum pofizeni Znacky

Wy Usporadat ~

FF Dokumenty Hledani neodpovidaji Zddné polozky.

Daléi »

Slozky
. Pixologic
. GoZApps
GoZBrush
. GoZProjects
Default
. Recorded TV
.

Nazev souboru: v
Uloiit jako typ: | OBJ Format *.obj %

 Skryt slozky

Nyn| se musime
rucné prepnout do

_Display Render Animation Window

pracovniho okna Poseru
a zde aktivovat objekt
kalhotek.

Jakmile to mame
vykonano pouzijeme
prikaz menu Object >
Load Morph Target.

V nasledujicim
dialogovém okné
musime pomoci tlacitka
se tfemi teckami

zadat cestu k souboru
geometrie, ktery jsme
pred chvill vytvorili,
potvrdit nebo zadat
vhodnéjsi nazev
vysledného morph

targetu a volbu potvrdit.

Nové vytvoreny otoCny
ovladac morph targetu
na]deme v knihovné
ovladact objektu
kalhotek. Pokud tento
ovladac nastavime

na hodnotu 1,000,

Propemes Ctrl+I
Lock Actor

Change Parent...
Add Constraint...
Point At...

Replace Body Part with Prop
Load Morph Target

Spawn Morph Target

Export Object Mesh To GoZ...

Create Grouping
Create Light
Create Camera
Create Magnet
Create Wave

Create Wind Force
Delete Object
Load Morph Target

Geometry file: CandyPanty!1.
Label: CandyPanty!l

I1| Attempt vertex order correction

Cancel oK

mdzeme opét posoudlt vysledny efekt. Jak to dopadlo
v mém pripade, miZete posoudit z obrazku na

nasledujici strané.

Timto jsme dospéli do konce 13. lekce Skoly Poseru
zaméfené na tvorbu morph targetd (deformaci) pomoci
externi aplikace. PouZili jsme aplikaci ZBrush a vyuZili
jsme moznosti propojeni s Poserem pomoci pluginu
GoZ, ktery vyraznym zplisobem zjednodusuje praci. Na
druhou stranu se jedna 0 nastroj, ktery se dosud vyviji
a nemusi fungovat ve vsech pripadech stoprocentné.

PfiSel jsem jiz na jeden problém, ktery zatim neni
vyresen. Pokud totiz u postavy Poseru pouZijete navic
objekt dynamickych vlasti, pfi pokusu o export postavy
do ZBrushe dojde k padu apllkace Poseru vCetné ztraty
neuloZené prace. Tomuto pripadu se musime prozatim
vyvarovat. Dynamické vlasy pouZzivaji nestandardni
model geometrie a ten bude zfejmé kamenem drazu. V
budoucnu se snad tento problém podafi vyresit.

Jeste bych chtél upozornit na dalsi mozny problém,
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ktery by mohl byt zplisoben preinstalaci nebo instalaci
nove verze ZBrushe. Na zaCatku této lekce jsme si
vysvetlili, Ze potfebné soubory pro komunikaci pluginu
GoZ s Poserem byly vytvoreny instalaci servisniho_
balicku SR3 Poseru v adresafi ZBrushe. Jestli se pfi
instalaci nové verze ZBrushe tento adresaf smaze nebo
piepiSe, bude nutné soubory Poseru obnovit. Lze to
udelat opétovnou instalaci servisniho balicku SR3, nebo
si ty soubory budeme muset pred instalaci nové verze
ZBrushe zélohovat a pozdéji je ze zalohy obnovit.

Objekty z Poseru do ZBrushe a zpét je mozné také

('”I//u
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exportovat jinym zplisobem, ktery se pouZival pred
vytvorenim GoZ pluginu. V této lekci jiz stary zpusob
exportu popisovat nebudu, protoze by to mohlo by
matouci. Pravdépodobné tento zplsob nekdy popisi
v rubrice Tipy & Triky, protoZe tento zp{isob je sice
pracnéjsi, ale na druhou stranu zcela spolehlivy.

V piipadé né&jakych nejasnosti nebo dotazli mé
nevdhejte kontaktovat nejlépe pomoci diskuzniho féra,
které je soucasti webu poser.4fan.cz. Pfimy odkaz je
na prvni strance této lekce pod interaktivnim tlacitkem.

Mnoho zabavy pfi préci s Poserem preje PET5!
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